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Document No: D0233 (5) 

http://www.data-harvest.co.uk/


EASYSENSE VISION  D0233 (5) 

    Data Harvest Group Ltd. 3 

 

 

Upon receipt of your VISION logger:  
Connect VISION to its mains power supply overnight to charge the battery before use.  
 

If screen taps are not accurate recalibrate the stylus control by using VISION’s screen calibration 
utility (see page 8).  
 
 

Items included with VISION 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
A spare stylus 

 

 

 

 

 

 
VISION will operate with most standard USB accessories: 

 Mouse – standard, mini, wired or wireless  

 Keyboard  

 USB Memory stick – FAT format (NTFS formatted drives are not suitable).  

 USB powered Port Hub - V1.1 or V2  

 

 

EASYSENSE VISION fitted with a stylus  

A power supply 

A USB cable 

Two short Smart Q sensor leads 

Two long Smart Q sensor leads 
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The VISION data logger 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

VGA out for connecting 
to a standard data 
projector or monitor   

USB Host: Use to connect a USB 
Mouse, Keyboard, Pen drive 
(memory stick), powered Hub, 
Printer (HP PCL compatible), etc.  

 

USB Client 
Connect VISION to a host computer via a USB lead to: 
• Transfer captured data from VISION to the PC  
• Use VISION as an interface and capture data using the EASYSENSE PC software 

 

 

Power socket – connect to power 
and to recharge the built in battery  

Power light  

Power button  

 

 4 inputs for plug-in Smart Q 
sensors 

 (Input 1 and 2 are dual labelled 
as A and B for timing operations) 

Stylus 

Underside is the battery 
compartment for the lithium-ion 

rechargeable battery pack 

Stylus in its storage slot 

 

Power On/Off   

Touch screen   
(high resolution 
colour graphic 
display) 

 4 Smart Q sensor inputs  
USB Host 

USB Client 

VGA port  
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The different ways to capture data using VISION  
 

1. Stand alone – data collection and analysis is operated by a stylus, touch (finger tip) or a 

USB mouse.  
 

Data is:  
a) Viewed on the graphical touch screen in Meter mode. 
b) Captured and analysed using one of the logging options i.e. EasyLog, SnapShot, Graph, 

Scope or Timing. The collected data can be saved and stored in user memory. 
c) Displayed to the whole class via a projector or monitor using the VGA out socket. See page 8.  

 

2. PC connected  
a) As an interface (controlled by the EasySense software on the PC computer). See page 9. 
b) Data saved on VISION can be opened in the EasySense PC software. See page 10 and 11. 
c) Workroom setup files can be transferred to and from VISION.  
d) Windows Explorer can be used to manage VISION’s file storage area e.g. Delete, Copy, 

Rename, etc. See page 10. 

 

To capture data standalone 

 Connect any Smart Q sensors to the inputs on VISION (see page 7 for more information).  
 

 Ensure VISION has sufficient battery power or connect to its power supply (see page 12 for 
charging information). 
 

 Short press the green power button (for a second) then release. If the screen remains blank 
VISION is powered down so press and hold down the power button until the starting screen 
appears.    

 

 Select an experimental mode from the Home screen i.e. EasyLog, Graph, Meters, Scope, 
SnapShot or Timing.  

 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

Automatic standby (sleep mode) 
If EASYSENSE VISION is battery powered and left user idle (no screen taps, button press or 
mouse movement) for more than  

 60 seconds its screen will automatically dim. Touch or tap the screen to return to full brightness. 

 90 seconds or more the screen will go blank (sleep mode). VISION will continue to record (if 
logging). To resume operation, touch or tap the screen, short press the green power button or 
move the mouse (if attached). 

 

If the interval between samples is 10 seconds or more VISION will automatically use sleep mode 
and will wake each time it needs to take a reading.  

The Home screen 
(Level 2 & 3) 
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The EasySense software overview 
Detailed information is available in the EASYSENSE VISION software guide (DO234) available on 
from the Resources tab at www.data-harvest.co.uk/vision. 
 
Select a User level 
The first time VISION is started a ‘Select Program Level window may automatically open. Select a 
suitable user level - Level 1 is aimed at ‘start’ level (e.g. up to 9 years old), Level 2 is aimed at ‘mid’ 
level (e.g. 9 – 15 years old), Level 3 is aimed at ‘exam’ level (e.g.15 years plus).  
 
Note: The program level can be altered once a logging option has been opened.   
 

The Home screen 
Home is the main navigation window, which contains the icons for all the logging 
options.The options available and the complexity of the toolbars and functions are 
altered by the user level selected.  

 
Meters 
The Meters window gives an introduction to sensors and how they respond to change. 
Up to four section displays can be open at any one time and they can be any 
combination of sensors and displays.  

 
The program will open with live data from one sensor in a Numeric window. Click on the appropriate 
picture icon on the Menu bar to open other section displays i.e. Numeric, Gauge, Colour Change or 
Bar. To alter the sensor displayed in a section, tap & hold (or right click with a mouse) in the 
individual section window and select the sensor from the list.  
 

Click on the Stop icon  to stop logging.  

 
EasyLog 
EasyLog will open pre-set to record sensor values continuously as a line graph until 

stopped. Click on the Start icon  to start recording.          
 

Logging will start with a time span of 30 seconds and when this has elapsed the time will double 
automatically. This will continue until the recording is stopped by clicking on the Stop icon.  

 
Snapshot 
Snapshot will open pre-set to record sensor values on demand (manual sampling) 
with a bar graph display. 
 

Click on the Start icon  to start recording. Click in the graph area to record the current value for 
each active sensor. Click on the Stop      icon to stop data being recorded.    

 
Graph 
Graph is pre-set to record sensor values against a chosen time span as a line graph 
display. The window opens with the logging wizard from which the time span, interval 
between samples, start condition and triggers for the recording can be chosen. (The 
options available will depend on the level you have selected to work at). When the 
selection has been made, click on Finish. 

 

Click on the Start icon  and the recording will start when the start condition you have selected is 
met e.g. if None was the selected trigger then the recording will start as soon as the Start icon is 
clicked. The recording will stop when the selected time span has passed.  
 

Note: If you want to stop a recording before it has run the full term, click on the Stop  icon.  
 

Logging rates can be set from 50,000 samples per second (20 s interval) for capturing fast moving 
data) to 1 sample an hour (for long term experiments).  

 

 

 

 

 

 

 

http://www.dataharvest.co.uk/products.php?g=sci&ppg=sci&a=sec&ppa=sec&t=dl&code=2020
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  Scope       (User level 2 and 3 only) 

The data from the sensor is redrawn continuously on the screen in a simple 
oscilloscope type display.  

 

Click on the Start icon  to begin recording. In roll mode the graph trace will be redrawn 

continuously on the screen until you click on the Stop icon  when the trace will ‘freeze’.  
 

Note: Scope is not available when the User level is set to Level 1. 

 
Timing 
Timing is used to allow students to study Time, Velocity, Acceleration, Momentum and 
Kinetic Energy relationships using switch-type (digital) sensors such as Light gates.  

 
Sensors must be connected to either input 1:A or inputs 1:A and 2:B. 
 
A recording wizard will open with the options available to select before recording data. (The 
availability will depend on the level you have selected to work at). When the selection has been 
made, click on Finish.  

 

Click on the Start  icon and a reading will be displayed when a change is detected in a signal 
from the digital sensors.   

 
Open 
Use to load a previously saved data file. Locate the correct EasySense file (.SSL) 
and select OK. See page 11. 

 
Interface 
Use to connect VISION as an interface controlled by the EasySense software on 
the PC computer. See page 9. 

 
Apps  
Use to open or manage other applications available on VISION e.g. the Periodic 
Table. See page 14. 

 

Smart Q Sensors  
Smart Q Sensors are each equipped with a sophisticated microprocessor that greatly improves the 
sensor’s accuracy, precision and consistency. The auto-identification circuitry simplifies set up 
procedures and allows for greater flexibility when logging data.  
 
The four inputs on the top edge of VISION may be used with analogue and digital sensors. Both will 
be recorded side by side during logging operations.  
 
Sensor inputs 1 and 2 are dual labelled as A and B. These inputs 
are for Timing operations when digital sensors must be connected 
to either input 1:A or input 1:A and 2:B. 
 
 
 
Four sensor leads have been provided to connect Smart Q 
Sensors to the shaped input sockets on VISION.  
 
 
Smart Q Sensors are available to purchase separately and 
are not supplied with VISION.  
 

Input socket Sensor cable 
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TIP: If the inaccuracy of screen taps makes 
this selection difficult use a USB mouse. 

 

Sensors can be divided into two main types: 
 
1. Analogue – used to measure 

physical quantities such as 
temperature, sound, light, pH, etc. 

 
2. Digital switch-type sensors for measuring ON/OFF conditions 

e.g. Light gates and Timing mats to calculate time, speed and 
acceleration.  

 
Please contact your supplier or the Data Harvest website (www.data-harvest.co.uk) for up-to-date 
information on Smart Q sensors.  

 

Calibrating the screen  
If screen taps are not accurate recalibrate the screen using VISION’s screen calibration utility.  
 

 From the Settings menu select System Settings. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 From the Calibrate Screen section select Do it.  
 

 Enter DHG2020 as the password. 
 

Note: The password is case sensitive, so make sure DHG is in capitals. This password cannot be 

changed by the user.   
 

 Tap and hold the stylus on the centre of the target for about 4 seconds, when you release the 
tap the target will move (if not tap and hold firmly for longer). Repeat as the target moves around 
the screen (for the four corner positions). 

 

 A message will indicate the new calibration settings have been measured, tap anywhere on the 
screen to save the calibration and exit.   
 

Note: To cancel your attempt wait for 30 seconds without doing anything and the new settings won’t be 

saved.   
 

 Tap on   to close System Settings.  

 

Connecting VISION to a projector or monitor 
As VISION’s LCD screen will be off when used with a VGA display device, 
you will need to connect a mouse to control VISION. 
 
It is best to connect VISION to its mains power supply to prevent it going to sleep.  

 
Note: If battery powered, ensure VISION is awake when connecting the VGA lead and use a screen tap to 

wake VISION from sleep (the mouse will not respond). 
 

 
Do it 

Password = DHG2020 

http://www.dataharvest.co.uk/products.php?g=sci&ppg=sci&a=sec&ppa=sec&t=sen&code=na&default=yes&mlev=7&show=7&title=Sensors
http://www.dataharvest.co.uk/products.php?g=sci&ppg=sci&a=sec&ppa=sec&t=sen&code=na&default=yes&mlev=7&show=7&title=Sensors
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 Connect a USB mouse to the USB host port            on VISION. 

 Connect the VGA lead from a projector or monitor to the VGA port          on VISION.  
 
The display device should automatically be detected by VISION and the display will switch from the 
LCD display to the VGA display device. 
 
If VISION does not detect the VGA device, a manual switch must be made: 

 From the Settings menu select System Settings. 

 From the Display menu select Change. 

 VISION will now switch to the VGA display device 
 
Note: As a safety measure, VISION will now give you 15 seconds to click on OK to stay on the VGA 

device; otherwise it will automatically switch back to the LCD display. 
 

When you have finished using the VGA display device, either go back into System Settings and 
click change again or switch VISION off and on (it will always default back to LCD at power up). 

 

Using VISION as an interface (controlled by the EasySense 
software on a PC computer)   

 
V3.0 or later of the EasySense PC software must be installed on the PC computer.  
 

 Save any data you have on screen. 

 Connect VISION to the PC using the USB cable supplied (connect the ‘square’ type B plug of 
the USB cable to the USB client port         on VISION and connect the ‘flat’ type A plug to a USB 
port on your computer).  

 
 

 

 

 

 Select Interface either from VISION’s Home 
screen or the PC Connection menu.  
 
 

VISION’s screen will alter to 
show its USB connected.  

 
 
Note: If VISION does not find a connection with the PC within 10 seconds VISION’s EasySense software 

will automatically restart.  
 

 The first time VISION is connected allow the USB device 
drivers to install. 

 

 Open the EasySense software on your PC computer e.g. 
Start ► Programs ► Data Harvest ► and double click on 
EasySense Software.  Select a new experiment mode 
from the Home screen i.e. EasyLog, Graph, Meters, 
Scope, SnapShot or Timing.  

 

Logging rates can be set from 50 samples per second (20 ms 
interval) for capturing real-time data.  

 
 
When you’ve finished using VISION as an interface, disconnect VISION from the USB port and 
VISION’s EasySense software will restart.  

 

 

Interface 
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The first time the EasySense PC software is opened: 
 

Step 1.  A ‘Select Program Level’ window will automatically open. Select a suitable user level.  
 
Note: Level 1 is aimed at ‘start’ level (e.g. up to 9 years old), Level 2 at ‘mid’ level (e.g. 9 – 15 years old) and 

Level 3 at ‘exam’ level (e.g.15 years plus).  
 
 

Step 2.  
A ‘Select Interface’ window will automatically open to allow 
the correct interface and connection to be selected. 
(a) Select the EasySense Range. 
(b) Select the appropriate connection as USB Port. 
(c) If these settings will stay the same leave the ‘Show at 

startup’ box unticked.  
(d) Click on OK. The program will save the current selection.  
 
 

 

Transferring files between VISION and a PC computer  
Saved data files can either be transferred from VISION to your PC by using VISION in ‘disc drive’ 
mode or can be opened direct into the EasySense PC software by using the Retrieve Remote 
function while VISION is connected as an interface. 
 
Saved setup and bitmap files can be transferred from VISION to your PC by using VISION in ‘disc 
drive’ mode. 
 

 Save any data you have on screen. 

 Connect VISION to the PC using the USB cable supplied (connect the ‘square’ type B plug of 
the USB cable to the USB client port         on VISION and connect the ‘flat’ type A plug to a USB 
port on your computer).  

 

Using VISION in Disc Drive mode  

 From the Home screen select Disk 
Drive from the PC Connection 
menu. 
 
VISION’s screen 
will alter to show 
it’s USB 
connected.  
 

 The first time VISION is connected allow the USB device drivers to 
install. VISION will appear as a removable storage device on the 
PC (no special drivers are required).  

 
Windows Explorer can be used to drag and drop files between 
VISION and your PC (maximum file size for VISION is 5 MB). 
 
Note: If no connection is made to the PC within 8 seconds then VISION’s 

EasySense software will restart.  
 

 When you’ve finished safely remove VISION from the PC e.g. by using the Safely Remove 
Hardware icon from the computer’s taskbar and once safe to do so disconnect VISION from 
the USB port. VISIONs EasySense software will restart.  

 

(a) 

(b

) 

(c) 

(d) 
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With VISION connected as an Interface 

 Select Interface either from VISION’s Home screen or the PC Connection menu.  
 
 

VISION’s screen will alter to show it’s USB connected.  

 
 Open the EasySense software on your PC computer e.g. Start ► Programs ► Data 

Harvest ► and double click on EasySense Software.   
 

 Select Retrieve Remote from the PC’s Home screen. 
 

 Select the data file from the list then Retrieve.  
 
When you’ve finished using VISION as an interface, disconnect VISION from the USB port and 
Visions EasySense software will restart.  
 

Opening and Saving files 
 

Opening 
If you are opening a file saved on a memory stick connect the USB memory stick to the USB host 
port on VISION before selecting Open. 
 

 Select Open either from the Home screen or from the File menu.  

 Locate the EasySense data file (.SSL) and OK.  
 
Saving 
If you are saving to a memory stick connect the USB memory stick to the USB host port on VISION 
before selecting Save As. 
 

 From the File menu select Save As.  

 A dialogue box will open to allow the captured data to be saved as an EasySense file. Select the 
destination of your choice. 

 Type in a name for the file (saved by default as .SSL type). 
 

Auto save 
If the battery voltage level drops too low then VISION will auto-save data before shutting down. If 
this happens connect VISION to mains power and hold down the power button until the starting up 
screen appears. Select Open from the File menu – the data that had been collected will be saved in 
an .SSL file called Auto-Saved Data in the User Files\Data Files folder.  

 

Printing 
VISION will print to most Hewlett Packard PCL compatible printers.   
 
Connect a compatible printer to the USB host port            on VISION (printer turned on).  
Print Graph or Print Table* is located in the File menu. 
 
Note: VISION will only print greyscale with a HP Colour LaserJet printer (not in colour).  

 

* Be aware that a table can use multiple pages to print. 
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System information 

Powering EASYSENSE VISION 
While VISION is connected to its mains power supply it will not use sleep mode and will remain 
awake.  
 
Generally there is no need to power down (reset) VISION except to speed up a battery recharge or 
to restart VISION’s EasySense software if a fault occurs. (Saved data will be safe, but any unsaved 
data will be lost).  
 
 To power down VISION: press and hold down the green power button for about 4 seconds – a 

red warning symbol will appear , continue to hold until the screen goes blank.   
 
 To power VISION back on: press and hold down the green power button until the ‘Application 

loading’ screen appears. 

 
Mains power 
Use VISION’s mains power supply adapter to power and recharge its internal batteries. Connect 
the power adapter to the power socket on the back of VISION and its power indicator will light.  
 
Power supply specifications: 5V DC mains adaptor, able to supply 1000 mA, with a positive centre 
and negative outer pin.  
 

 
Recharging batteries 
Connect VISION to its mains power supply adapter and leave to charge overnight. 
 
Notes:  

 Normally VISION will fully charge overnight but may take longer if its battery is totally flat.  

 To ensure the fastest charging time unplug all sensors and peripherals (keyboards, mice, projectors, etc.).  

 To divert all power to recharging VISION’s batteries, power VISION down (press and hold down the power 
button for about 4 seconds until the screen goes blank).  

 

 

Batteries  
VISION is fitted with a rechargeable lithium ion battery pack.  
 
Battery life will depend on the sensors connected. For example a fully charged battery in good 
condition can power VISION in EasyLog mode with a Light level sensor connected for up to 14 
days. If a high current sensor such as the Rotary Motion sensor is used then this will be reduced to 
less than 2 days.   
 
Even when turned off, VISION will use a small amount of current, and the battery will slowly 
discharge.  
 
Lithium ion batteries are ‘memory-free’ and prefer a partial rather than a full discharge. Constant 
partial discharges with frequent recharges will not cause any harm. Frequent full discharges should 
be avoided whenever possible.  
 
The speed at which a lithium ion battery will age is governed by both its storage temperature 
(preferably less than 40ºC) and state-of-charge. Eventually the battery pack will no longer deliver 
the stored energy and will need to be replaced. A fully charged battery that looses its charge quickly 
will demonstrate the need for replacement. When this happens contact Data Harvest and request a 
battery replacement pack for VISION – Product No. 2036. (Full instructions on how to replace the 
battery will be supplied with the replacement battery). 
 
Lithium batteries operate best at near room temperature (between 10 and 30˚C) but can be used at 
any temperature between 5 to 50˚C. If VISION has been left in the cold, let it warm to near room 
temperature before use.   
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Battery voltage  
 Select System Settings from the 

Settings menu.  

 Battery Voltage will show an estimate of 
VISION’s current battery voltage level.  

 

 

 

 

 

Memory Free 

This value indicates the percentage of free memory 
available for storing user data or setup files.  

 

Deleting files 

There are two methods of deleting saved files (to free more memory).  
 

1. Select System Settings from the Settings menu. From the Memory Free section select Delete 
Files. Select the appropriate data file (.ssl) or user setup file (.sss) from the list, and select 
Delete. Tap on       to close System Settings.  

 

2. Connect VISION to the PC in Disc Drive mode (see page 10). VISION will appear as a 
removable storage device on the PC; use Windows Explorer to delete files from VISION’s file 
storage area.  

 

Set date & time: 
To set the date and time on VISION select System Settings from the Settings menu.  
 
Time: Select any numbers that are not correct and use the left pointer ◄ to reduce its value or the 
right pointer ►to increase its value.   
 
Date: Select the down pointer ▼to open a calendar. Use the left or right pointers to scroll through 
the months and years and select the correct date. 
 

Tap on   to close System Settings.  
 

Language 
If your VISION has a choice of languages there will be a Set Language option available from the 
Settings menu. Select the appropriate language from the drop down menu and then OK. The 
software will restart using the selected language.   
 

Keyboard 
Tap on the coloured title bar and drag to move the 
keyboard to a different position on the screen.  
 
 
 
Select Keyboard 
Use Select Keyboard (Settings menu) to change your keyboard from a standard size to a larger 
keyboard. The keyboard will revert automatically to standard size if VISION is restarted.   
 
Note: If a USB keyboard is attached to VISION then the on-screen keyboard will not appear. 

 

 

 

Between 40 and 60% 

Between 20 and 40% 

Between 60 and 80% 

Between 80 and 100% 

Between 0 

and 20% 
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Apps 
Select Apps either from the Home screen or File menu to open or manage additional applications 
that have been installed on VISION e.g. the Periodic Table, Scientific Calculator. 
 
To install a new App 

 Download and Save the compressed application from the App Store at www.dataharvest.co.uk 
to your PC computer. ‘Unzip’ to extract the contents. Copy the application directory to the top 
level of a USB memory stick. 

 Connect the USB memory stick to the USB host port             on VISION. 

 Select Apps either from the Home screen or File menu. 

 Select Install/Update from the Settings menu. 

 Select the application to install from the list and OK. 
 
To uninstall an App 

 Select Apps either from the Home screen or File menu. 

 Select the application you want to remove. 

 Select Remove from the Settings menu. 

 Enter DHG2020 as the password (the password is case 
sensitive, so make sure DHG is in capitals) and OK. 

 

Technical specifications 

 4 Smart Q sensor inputs 

 VGA Out  

 USB Host (1.1) 

 USB Client (1.1) for connection to host PC 

 4.3” LCD Touch Screen (approx. 55 mm high x 95 mm wide - 115 mm diagonal).  

 Rechargeable battery pack: Lithium-ion 3.7 V, 4400 mAh 

 Mains power supply: 5 V DC 1.0 A (Positive centre, negative outer pin) 

 Maximum logging speed (per channel): 20 μs between samples (50 kHz) 

 Digital timing from A to B: 4 μs resolution  

 12 bit analogue sampling resolution 

 Firmware upgradeable 

 External dimensions: Approx. 53 mm high x 160 mm wide x 115 mm deep 

 VISION (logger only) weight: approx. 410 g  
 

Care & maintenance 
 VISION is designed to be operated on a desk or hand held. 
 

 Wipe clean with a lint-free soft dry cloth e.g. a microfiber cloth that is specifically designed to 
clean glass.  

 

 Do not use any liquid or cleaning agent. 
 

 A standard SONY PSP LCD clear Screen Protector (not PSP Go) can be utilised to protect 
the screen from surface scratches.  

 VISION is not water or shower proof.  If it is to be used in an environment where it could get 
wet, precautions must be taken to ensure that liquid cannot enter the unit.  

 

Note: If placed in a waterproof housing e.g. a plastic box, ensure that condensation does not make 

contact with VISION. 
 

 VISION is suitable for use in temperature ranges of 5 to 50˚C and 0 to 95% RH (non-
condensing). 

Password = DHG2020 

http://www.dataharvest.co.uk/
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 If VISION has been left in the cold, let it warm to near room temperature before use.   
 

 Do not subject to extreme heat or cold. Do not expose to direct sunlight for extended periods 
of time. Do not expose to temperatures greater than 60˚C, e.g. near a heater or inside a car 
in hot weather.  

 

Troubleshooting 
Should VISION fail to respond or before reporting a fault please attempt a reset, which is available 
at two levels.  
 

 Reset – to restart VISION – saved data will be safe, but any unsaved data will be lost.  

 Factory Reset – this will reset VISION to its factory settings. All user memory will be cleared 
(user created data and setup files will be erased). 

 

1. Select System Settings from the Settings menu.  
 

2. From the Troubleshooting section select either Reset or Factory 
Reset and say Yes to the warning message.  

 

3. VISON will automatically reset and the start up screen will appear.    
 

There are no serviceable parts inside VISION. If you are experiencing a problem, please contact 
Data Harvest. 
 
Please provide details of: 

 The type of unit being used i.e. VISION. 

 A description of the problem being encountered. 

 The VISION’s software and firmware version numbers (available from Help ► About). 

 If being used with a PC, the computer platform with which it is being used and the EasySense 
PC software’s version number. 

 
If the problem is encountered when in use with a PC, please telephone from a location where 
you can operate VISION and the PC. 

 
Note: Dismantling VISION will invalidate the warranty and may render the unit un-repairable. 
 

Battery replacement 

When replacing the battery, only use a replacement battery pack supplied by Data Harvest (Product 
No. 2036). (Full instructions on how to replace the battery will be supplied with the replacement 
battery pack). 
 

Updating EASYSENSE VISION’s firmware  

Occasionally Data Harvest may release updated firmware which will contain improvements or new 
features. Firmware updates and instructions on how to upgrade will be made available from the 
Resources tab at www.data-harvest.co.uk/vision. 
 
To determine the version of firmware and software and release your VISION is currently using select 
About from the Help menu.  
 
Warning: User data and setup files will be erased as part of the update process. Please ensure that 
you have transferred all user files stored on VISION to a memory stick or PC before updating. 

 

 

 

 

 

http://www.dataharvest.co.uk/products.php?g=sci&ppg=sci&a=sec&ppa=sec&t=dl&code=2020
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Using VISION WiFi with Apple iPad 
 

VISION WiFi can operate in two different modes: 
 

1. Connected to its own local network (Access Point) 
VISION WiFi is set to Access point by default. In this mode the iPad connects to a network created 
by VISION. This connection is typically used when not in range or able to access the school’s 
network (perhaps on a field trip). While connected to VISION in Access mode, the iPad will NOT be 
connected to any other networks, and therefore unable to access other items such as web pages, 
email, cloud storage, etc. 
 

2. Connecting to an existing school’s network (Infrastructure) 
In this mode VISION WiFi and the iPad connect to the same existing network. It has the advantage 
of allowing the iPad to remain connected to other resources delivered by the school network, such 
as web access, email, printing and cloud storage facilities, etc. 
 

The EasySense App 

EasySense iPad is a free app. Search for ‘EasySense’ in the App Store on your iPad and install. 
 

Using VISION in WiFi mode 
It is recommended that VISION is connected to its mains power supply when used in WiFi mode 
as the power requirements are high, and will drain the battery quickly.  
 
To start using VISION in WiFi mode: 
 

1) From the Home screen tap on the Apps button 
 
2) Double tap on the WiFi icon. 
 
After a few seconds a VISION WiFi screen with a green tick will appear. 
VISION is now ready to be used. 
 
Notes 

 The name of the VISION logger and the network currently selected is shown on this screen. This 
information is required when connecting an iPad to the VISION. (To rename a network or VISION, see 
‘setting up the wireless network’). 

 

 VISION WiFi uses 802.11b. Make sure the WiFi network is compatible with b mode. 
 

Connection to an existing network (Infrastructure) 
 

1) From the VISION WiFi screen tap on Settings. 
 

2) Enter DHG2020 as the passphrase, OK.  
 

3) Give the VISION logger a new name (optional). 
 

4) Tap the Infrastructure radio button. 
 

5) Select the schools network from the list that appears, OK. 
 

6) If required enter the passphrase (provided by 
your school network administrator), OK.  

 

7) Tap on OK. 
 
After a few seconds the VISION WiFi screen (with green tick) will 
reappear, VISION is now connected to the selected network. 
 
It is possible to connect a number of VISION WiFi loggers to the school 
network simultaneously, each with its own unique name. From the iPad 
simply select the required VISION by choosing it from the list provided inside 
the EasySense iPad software. 
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VISION network connection (Access Point) 
 

1) From the VISION WiFi screen (on VISION), tap on Settings. 
 

2) Enter DHG2020 as the passphrase, OK.  
 

3) Change the name of the VISION logger (optional). 
 

4) Tap the Access Point radio button. 
 

5) Enter a name for the network to be created (optional). 
 

6) Tap on OK.  
 

After a few seconds the VISION WiFi screen (with 
green tick) will reappear. VISION has now created its 
own network. 
 
Note: It is possible to have multiple VISION WiFi loggers each creating their own separate networks. 
 

Connecting to VISION WiFi from the iPad 
1) Ensure VISION is in WiFi mode by running the WiFi App (shows 

the WiFi screen with green tick). 
 

2) Ensure the iPad is connected to the same network as VISION: 
 

 

 Tap on the Settings icon on the iPad. 
 

 Tap on the Wi-Fi link. 
 

 Ensure the Wi-Fi button is in the ON position.  
 

 Choose from the list of available networks.  
 

 

 Enter a network passphrase if asked.  
 
 

 A tick will appear next to a network once it has been joined.  
 

 

3) Start the EasySense App on the iPad. 
 

4) Tap on the status button ‘Not Connected’ on the bottom right of the screen. 
 

5) Select a VISION logger from the list. 
 

6) The status button will change to show that it is ‘Controlling Vision xx or Viewing Vision xx’. 
 

 
To exit VISION from WiFi mode select the Exit button from VISIONs WiFi screen and VISION will restart.  
 

Connecting a group of iPads to a VISION 
It is possible for a group of iPads to connect to one VISION WiFi simultaneously to allow students to 
work collaboratively on a single experiment. 
 

When connecting to VISION, the first iPad to connect is given ‘control’ of the logger and will 
therefore be able to setup, start and stop the experiment. All subsequent iPads that connect to the 
logger are given ‘Viewer’ status, they will see the setup changes made by the controller, and as 
data is captured it will appear in real time. 
 

When the recording stops, all iPads will automatically save their own copy of the captured data in 
the internal iPad memory. One iPad cannot change or delete the data held on another iPad. 
 

To leave a group, simply tap on the status button again to disconnect (bottom right of the iPad 
screen). 
 

To release or swap control of the VISION, the controlling iPad simply taps on the status button; this 
will disconnect all iPads. (A new controlling iPad can be chosen by ensuring that it is the first to re-
connect.) 
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Technical Details 

VISION WiFi is a wireless enabled data logger. It is classed as a mobile device and has a usable 
transmission range of 0.2 m to 10 m in open air. 
 

 Compatible with IEEE 802.11b 

 Supports WEP, WPA-Personal (TKIP) and WPA2-Personal (AES) Security (802.11i)* 

 Frequency Range: 2412-2462 MHz 

 Channels supported: 1 to 11 

 Connections: 6 devices per VISION 
 
*VISION WiFi will automatically detect and use the required security protocol. 
 
Hereby, Data Harvest Group Ltd., declares that this 2021 VISION WiFi is in compliance with the 
essential requirements and other relevant provisions of Directive 1999/5/EC. 
 
A full copy of the Declaration of Conformity can be obtained by writing to the following address: 
 
Data Harvest Group Ltd. 
1 Eden Court 
Leighton Buzzard 
Bedfordshire 
LU7 4FY 
UK 

 

Warranty 
EASYSENSE VISION is warranted to be free from defects in materials and workmanship for a 
period of 12 months from the date of purchase provided it has been used in accordance with any 
instructions, under normal laboratory conditions. This warranty does not apply if the 
EASYSENSE VISION has been damaged by accident or misuse. 
 
In the event of a fault developing within the 12-month warranty period, EASYSENSE VISION 
must be returned to Data Harvest for repair or replacement. Return postage costs are the 
responsibility of the customer. 
 

 

 

 

 

 

 

 

 

 

Note: EASYSENSE VISION is designed for educational use and is not intended for use in industrial, 

medical or commercial applications. 
 

WEEE (Waste Electrical and Electronic Equipment) Legislation 

 
Data Harvest Group Ltd is fully compliant with WEEE legislation and is pleased to provide a 
disposal service for any of our products when their life expires. Simply return them to us 
clearly identified as ‘life expired’ and we will dispose of them for you.  

 


